Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, AnyRate, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, KeeLoq, KeeLoq logo, Kleer, LANCheck, LINK MD, MediaLB, MOST, MOST logo, MPLAB, OptoLyzer, PIC, PICSTART, PIC32 logo, RightTouch, SpyNIC, SST, SST Logo, SuperFlash and UNI/O are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, ETHERSYNCH, Hyper Speed Control, HyperLight Load, IntelliMOS, mTouch, Precision Edge, and QUIET-WIRE are registered trademarks of Microchip Technology Incorporated in the U.S.A.


SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademarks of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.

© 2015-2016, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.
 ISBN: 9781522406907
Object of Declaration: EVB-LAN9252-HBI+

EU Declaration of Conformity

Manufacturer: Microchip Technology Inc.
2355 W. Chandler Blvd.
Chandler, Arizona, 85224-6199
USA

This declaration of conformity is issued by the manufacturer.

The development/evaluation tool is designed to be used for research and development in a laboratory environment. This development/evaluation tool is not a Finished Appliance, nor is it intended for incorporation into Finished Appliances that are made commercially available as single functional units to end users under EU EMC Directive 2004/108/EC and as supported by the European Commission’s Guide for the EMC Directive 2004/108/EC (8th February 2010).

This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU.

This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in compliance with the essential requirement and other relevant provisions of the R&TTE Directive 1999/5/EC and the FCC rules as stated in the declaration of conformity provided in the module datasheet and the module product page available at www.microchip.com.

For information regarding the exclusive, limited warranties applicable to Microchip products, please see Microchip’s standard terms and conditions of sale, which are printed on our sales documentation and available at www.microchip.com.

Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA

Derek Carlson
VP Development Tools

12-Sep-14 Date
# Table of Contents

## Preface

- Introduction ................................................................. 7
- Document Layout .......................................................... 7
- Conventions Used in this Guide ....................................... 7
- The Microchip Web Site .................................................. 8
- Development Systems Customer Change Notification Service .................................................. 8
- Customer Support .......................................................... 9
- Document Revision History ............................................. 9

## Chapter 1. Overview

1.1 Introduction ............................................................. 11
1.1.1 Abbreviations ......................................................... 11

## Chapter 2. EVB-LAN9252-HBI+

2.1 EVB-LAN9252-HBI+ in HBI Mode .......................... 12
   2.1.1 EtherCAT Master and Slave Configuration ............. 12
   2.1.2 HBI Demo .......................................................... 14

2.2 EVB-LAN9252-HBI+ in SPI Mode ........................... 17
   2.2.1 EtherCAT Master and Slave Configuration ............. 17
   2.2.2 SPI Demo .......................................................... 19

2.3 EVB-LAN9252-HBI+ Calculations ............................ 21
   2.3.1 Calculating Temperature ....................................... 21
   2.3.2 UART Decimal to ASCII Conversion ...................... 22
   2.3.3 DAC Calculations ............................................... 22

## Appendix A. Setting Up Master in Windows®

A.1 Introduction ............................................................. 23
   A.1.1 TwinCAT Ethernet Driver - Installation ................ 23

## Appendix B. EEPROM Programming

B.1 Introduction ............................................................. 27
   B.1.1 EEPROM Programming ......................................... 27

## Appendix C. Scanning EtherCAT Slaves

C.1 Introduction ............................................................. 30
   C.1.1 Scanning EtherCAT Slaves ....................................... 30

## Appendix D. Generating SSC Files

D.1 Introduction ............................................................. 34
   D.1.1 Generating SSC Files ............................................. 34

## Appendix E. Compiling and Programming SoC Firmware

E.1 Introduction ............................................................. 40
   E.1.1 Compiling and Programming SoC Firmware ............ 40
Appendix F. Programming PIC32 Firmware Using Pre-Built Binaries
   F.1 Introduction .................................................................................................. 42
   F.1.1 Programming PIC32 Firmware Using Pre-Built Binaries .....................42

Appendix G. Troubleshooting
   G.1 Introduction ...............................................................................................44
   G.1.1 Cannot Program PIC32 .............................................................................44
   G.1.2 Error when board requests PREOP .........................................................44
   G.1.3 Values Do not Update in Application ....................................................45

Worldwide Sales and Service ..............................................................................46
INTRODUCTION

This chapter contains general information that will be useful to know before using and configuring the EVB-LAN9252-HBI+. Items discussed in this chapter include:

- Document Layout
- Conventions Used in this Guide
- The Microchip Web Site
- Development Systems Customer Change Notification Service
- Customer Support
- Document Revision History

DOCUMENT LAYOUT

This document describes how to configure the EVB-LAN9252-HBI+, such as the DIGIO and SPI, as well as various setup options, scanning, and programming. The manual layout is as follows:

- Chapter 1. “Overview” – Shows a brief description of the EVB-LAN9252-HBI+ board quick setup.
- Chapter 2. “EVB-LAN9252-HBI+” – Provides instructions in configuring HBI and SPI.
- Appendix A. “Setting Up Master in Windows®” – This appendix shows how to set up Master in Windows.
- Appendix B. “EEPROM Programming” – This appendix shows how to program EEPROM.
- Appendix C. “Scanning EtherCAT Slaves” – This appendix shows how to scan EtherCAT Slaves.
- Appendix D. “Generating SSC Files” – This appendix shows how to generate SSC files.
- Appendix E. “Compiling and Programming SoC Firmware” – This appendix
shows how to compile and program SoC firmware.

- **Appendix F. “Programming PIC32 Firmware Using Pre-Built Binaries”** – This appendix shows how to program the PIC32 firmware using pre-built binaries.
- **Appendix G. “Troubleshooting”** - This appendix shows some basic troubleshooting tips for common problems.

### CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

<table>
<thead>
<tr>
<th>Documentation Conventions</th>
<th>Description</th>
<th>Represents</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arial font:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italic characters</td>
<td>Referenced books</td>
<td><em>MPLAB® IDE User’s Guide</em></td>
<td><em>is the only compiler...</em></td>
</tr>
<tr>
<td>Emphasized text</td>
<td>A window</td>
<td>the Output window</td>
<td></td>
</tr>
<tr>
<td>Initial caps</td>
<td>A dialog</td>
<td>the Settings dialog</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A menu selection</td>
<td>select Enable Programmer</td>
<td></td>
</tr>
<tr>
<td>Quotes</td>
<td>A field name in a window or dialog</td>
<td>“Save project before build”</td>
<td></td>
</tr>
<tr>
<td>Underlined, italic text</td>
<td>A menu path</td>
<td>*File&gt;*Save</td>
<td></td>
</tr>
<tr>
<td>with right angle bracket</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bold characters</td>
<td>A dialog button</td>
<td>Click <em>OK</em></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A tab</td>
<td>Click the <em>Power</em> tab</td>
<td></td>
</tr>
<tr>
<td>N'Rnnnn</td>
<td>A number in verilog format, where N is the total number of digits, R is the radix and n is a digit.</td>
<td>4'b0010, 2'hF1</td>
<td></td>
</tr>
<tr>
<td>Text in angle brackets</td>
<td>A key on the keyboard</td>
<td>Press &lt;Enter&gt;, &lt;F1&gt;</td>
<td></td>
</tr>
</tbody>
</table>

| **Courier New font:**     |             |            |         |
| Plain Courier New         | Sample source code | *#define START* |         |
| Filenames                 | autoexec.bat |            |         |
| File paths                | c:\mcc18\h |            |         |
| Keywords                  | _asm, _endasm, static |            |         |
| Command-line options      | -Opa+, -Opa- |            |         |
| Bit values                | 0, 1        |            |         |
| Constants                 | 0xFF, ‘A’   |            |         |
| Italic Courier New        | A variable argument | *file.c*, where *file* can be any valid filename |         |
| Square brackets []        | Optional arguments | mcc18 [options] *file* [options] |         |
| Curly brackets and pipe   | Choice of mutually exclusive arguments; an OR selection | errorlevel {0|1} |         |
| character: {}             |             |            |         |
| Ellipses...               | Replaces repeated text | *var_name [, var_name...]* |         |
| Represents code supplied by user | void main (void) { ... } |         |         |
THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web site is used as a means to make files and information easily available to customers. Accessible by using your favorite Internet browser, the web site contains the following information:

- **Product Support** – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software
- **General Technical Support** – Frequently Asked Questions (FAQs), technical support requests, online discussion groups, Microchip consultant program member listing
- **Business of Microchip** – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.

To register, access the Microchip web site at www.microchip.com, click on Customer Change Notification and follow the registration instructions.

The Development Systems product group categories are:

- **Compilers** – The latest information on Microchip C compilers, assemblers, linkers and other language tools. These include all MPLAB C compilers; all MPLAB assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK object linker); and all MPLAB librarians (including MPLIB object librarian).
- **Emulators** – The latest information on Microchip in-circuit emulators. This includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.
- **In-Circuit Debuggers** – The latest information on the Microchip in-circuit debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug express.
- **MPLAB IDE** – The latest information on Microchip MPLAB IDE, the Windows Integrated Development Environment for development systems tools. This list is focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and MPLAB SIM simulator, as well as general editing and debugging features.
- **Programmers** – The latest information on Microchip programmers. These include production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included are nonproduction development programmers such as PICSTART Plus and PIC-kit 2 and 3.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

- Distributor or Representative
- Local Sales Office
- Field Application Engineer (FAE)
- Technical Support
Customers should contact their distributor, representative or field application engineer (FAE) for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document.

Technical support is available through the web site at:
http://www.microchip.com/support

DOCUMENT REVISION HISTORY

<table>
<thead>
<tr>
<th>Revisions</th>
<th>Section/Figure/Entry</th>
<th>Correction</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS50002425C (06-22-16)</td>
<td>Entire Document</td>
<td>Updated to EVB_LAN9252-HBI+.</td>
</tr>
<tr>
<td></td>
<td>Appendix G. “Troubleshooting”</td>
<td>Added new appendix.</td>
</tr>
<tr>
<td></td>
<td>Chapter 1. “Overview”</td>
<td>Updated terms in abbreviations.</td>
</tr>
<tr>
<td></td>
<td>Chapter 2. “EVB-LAN9252-HBI+”</td>
<td>Updated entire chapter.</td>
</tr>
<tr>
<td></td>
<td>Section 2.3 “EVB-LAN9252-HBI+ Calculations”</td>
<td>Added new section to chapter with calculations.</td>
</tr>
<tr>
<td></td>
<td>Appendix B. “EEPROM Programming”</td>
<td>Updated pictures in appendix.</td>
</tr>
<tr>
<td></td>
<td>Appendix C. “Scanning EtherCAT Slaves”</td>
<td>Updated entire appendix.</td>
</tr>
<tr>
<td></td>
<td>Figure D-9</td>
<td>Updated figure.</td>
</tr>
<tr>
<td>DS50002425B (02-24-16)</td>
<td>Appendix F. “Programming PIC32 Firmware Using Pre-Built Binaries”</td>
<td>Added new appendix.</td>
</tr>
<tr>
<td></td>
<td>Appendix E. “Compiling and Programming SoC Firmware”</td>
<td>Added new appendix.</td>
</tr>
<tr>
<td></td>
<td>Appendix D. “Generating SSC Files”</td>
<td>Added new appendix.</td>
</tr>
<tr>
<td></td>
<td>Appendix D. Changing Vendor ID and Object Configuration</td>
<td>Removed entire appendix.</td>
</tr>
<tr>
<td></td>
<td>Appendix C. “Scanning EtherCAT Slaves”</td>
<td>Updated entire appendix.</td>
</tr>
<tr>
<td></td>
<td>Appendix B. “EEPROM Programming”</td>
<td>Updated entire appendix.</td>
</tr>
<tr>
<td></td>
<td>Appendix A. “Setting Up Master in Windows®”</td>
<td>Updated entire appendix.</td>
</tr>
<tr>
<td></td>
<td>Chapter 2. “EVB-LAN9252-HBI+”</td>
<td>Moved from Chapter 3. LAN9252-HBI</td>
</tr>
<tr>
<td></td>
<td>Chapter 2. DIGIO Configuration</td>
<td>Removed entire chapter.</td>
</tr>
<tr>
<td></td>
<td>Section 1.1 “Introduction”</td>
<td>Updated first paragraph. Added note.</td>
</tr>
<tr>
<td></td>
<td>Trademarks (Page 2)</td>
<td>Updated trademarks page.</td>
</tr>
<tr>
<td>DS50002425A (10-20-15)</td>
<td>Initial release of document</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 1. Overview

1.1 INTRODUCTION

This document describes how to use the EVB-LAN9252-HBI+ Software Development Kit (SDK) as a development tool for the Microchip EVB-LAN9252 EtherCAT® Slave Controller.

Note: All the figures in the document are captured from TwinCAT 3.1.

1.1.1 Abbreviations

ADC - Analog to Digital Converter
DAC - Digital to Analog Converter
ESC - EtherCAT Slave Controller
EVB - Evaluation Board
GPIO - General Purpose Input/Output
HAL - Hardware Abstraction Layer
HBI - Host Bus Interface
IDE - Integrated Development Environment
SPI - Serial Protocol Interface
SSC - Slave Stack Code
SoC - System on a Chip
UART - Universal Asynchronous Receiver/Transmitter
Chapter 2. EVB-LAN9252-HBI+

2.1 EVB-LAN9252-HBI+ IN HBI MODE

2.1.1 EtherCAT Master and Slave Configuration

The following steps describe how to configure the LAN9252-HBI:

1. Configure the Master with the TwinCAT driver.
   Refer to Appendix A. “Setting Up Master in Windows®” to configure the TwinCAT in Windows.


3. In the SDK, the \ESI Files directory contains the ESI files which can be loaded to EVB-LAN9252-HBI+ EEPROM using TwinCAT, as displayed in Figure 2-1.

Note: Vx.x denotes the version number of the SDK.

FIGURE 2-1: ESI FILES DIRECTORY

HBI ESI files:

<table>
<thead>
<tr>
<th>ESI File name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microchip EVB-LAN9252-HBI-INDEXED-8BIT.xml</td>
<td>Configures LAN9252 in HBI - Indexed 8-bit mode.</td>
</tr>
<tr>
<td>Microchip EVB-LAN9252-HBI-INDEXED-16BIT.xml</td>
<td>Configures LAN9252 in HBI - Indexed 16-bit mode.</td>
</tr>
<tr>
<td>Microchip EVB-LAN9252-HBI-MDP-8BIT.xml</td>
<td>Configures LAN9252 in HBI - Multiplexed dual phase 8-bit mode.</td>
</tr>
<tr>
<td>Microchip EVB-LAN9252-HBI-MDP-16BIT.xml</td>
<td>Configures LAN9252 in HBI - Multiplexed dual phase 16-bit mode.</td>
</tr>
<tr>
<td>Microchip EVB-LAN9252-HBI-MSP-16BIT.xml</td>
<td>Configures LAN9252 in HBI - Multiplexed single phase 16-bit mode.</td>
</tr>
</tbody>
</table>

Note: Refer to Appendix D. “Generating SSC Files” to change the Vendor ID and slave information in the ESI files.
4. Copy Microchip EVB-LAN9252-HBI-MSP-16BIT.xml for this example to the directory path C:\TwinCAT\3.1\Config\Io\EtherCAT for TwinCAT 3.1.

**Note:** There can only be one microchip .xml file present in the directory path at a time. Please remove any .xml not being used.

5. Configure the evaluation board in HBI mode and change the switches to 16-bit Multiplexed single-phase mode, as mentioned in “Section 2.4 Configuration” of EVB-LAN9252-HBI-SPI-SQI-GPIO EtherCAT User’s Guide, which can be downloaded from the Microchip website (http://www.microchip.com/Development-Tools/ProductDetails.aspx?PartNO=evb-lan9252-hbi).

6. By default, the corresponding ESI file of PIC32 firmware is flashed to the delivered EVB-LAN9252-HBI+. Refer to Appendix F. “Programming PIC32 Firmware Using Pre-Built Binaries”

To change the firmware in the PIC32 SoC, refer to Appendix D. “Generating SSC Files” and Appendix E. “Compiling and Programming SoC Firmware”.

**Note:** The pre-built binaries are available from the Binaries directory found in the SDK.

7. Launch TwinCAT and scan EtherCAT slaves from TwinCAT.

Refer to Appendix C. “Scanning EtherCAT Slaves” for steps on scanning EtherCAT slaves.

**Note:** Please reset the board using SW2 or go to TWINCAT -> EtherCAT Devices ->Reload Device Descriptions


Refer to Appendix B. “EEPROM Programming” for steps on EEPROM programming.

Once the EEPROM has been programmed, power cycle the board without closing the TwinCAT project.

If the EEPROM programming is successful, the state will change to ‘OP’ mode as displayed in Figure 2-2.
2.1.2 HBI Demo

The following describes a demo of EVB-LAN9252-HBI+ in HBI mode:

1. Follow the steps as provided in Section 2.1.1 “EtherCAT Master and Slave Configuration”. Eight demo objects exist, 3 Outputs and 5 inputs, that can be seen on the Solution Explorer of the TwinCAT tool, as displayed in Figure 2-3.

**Note:** If it changes to OP mode as highlighted above, then the device is in operational state. Otherwise there is an issue with the setup.
As part of this demo, eight object variables are mapped to PIC32 pins as detailed in Table 2-1.

### TABLE 2-1: OBJECT VARIABLE MAPPING

<table>
<thead>
<tr>
<th>Variable</th>
<th>PIC32 GPIO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Potentiometer (Input)</td>
<td>PIC32 RB1</td>
</tr>
<tr>
<td>Temperature Sensor (Input)</td>
<td>PIC32 RB0</td>
</tr>
<tr>
<td>UART Read Dword (Input)</td>
<td>PIC32 RF2</td>
</tr>
<tr>
<td>DAC Input (Input)</td>
<td>PIC32 AETXEN and PIC32 AETXCLK</td>
</tr>
<tr>
<td>Push Button (Input)</td>
<td>PIC32 RD3</td>
</tr>
<tr>
<td>DAC (Output)</td>
<td>PIC32 RB2</td>
</tr>
<tr>
<td>UART Write Dword (Output)</td>
<td>PIC32 RF8</td>
</tr>
<tr>
<td>LED_D24 (Output)</td>
<td>PIC32 RD2</td>
</tr>
</tbody>
</table>

2. To change GPIO inputs, click the Inputs process data mapping option under Box 1 in the Solution Explorer, as displayed in Figure 2-3.

The TwinCAT project window displays.

3. There are 5 different inputs that can be observed in Figure 2-4:
   - Potentiometer can be adjusted on the board (ADC Pot1: See Figure 2-7).
   - Temperature Sensor output can be used to calculate ambient temperature. Refer to Section 2.3.1 “Calculating Temperature” for more information.
   - UART Read Dword will display the information seen on RX from J24 RS232 connector. It will be a decimal number reflecting 4 characters. Refer to Section 2.3.2 “UART Decimal to ASCII Conversion” for information on converting this decimal number into hex and eventually ASCII.
   - DAC Input will display the input data going into the PIC. Refer to Section 2.3.3 “DAC Calculations” for how this number is obtained.
   - Push Button (SW50: See Figure 2-7) will be 1 when not pressed and 0 when pressed.
4. To view GPIO outputs, click Outputs process data mapping under Box 1 in the Solution Explorer, as displayed in Figure 2-3.

5. There are 3 different outputs that can be observed in Figure 2-5:
   - DAC is a value that can be set and will adjust the DAC output voltage as well as the ADC output. Refer to Section 2.3.3 “DAC Calculations” for more information.
   - UART Write Dword will output the value entered through TX on J24 RS232 connector in a repeated fashion.
   - LED_D24 can be set as high or low as can be seen in Figure 2-6 and on the board in Figure 2-7.
2.2 EVB-LAN9252-HBI+ IN SPI MODE

2.2.1 EtherCAT Master and Slave Configuration

1. Configure the Master with the TwinCAT driver.
   Refer to Appendix A. “Setting Up Master in Windows®” to configure the TwinCAT in Windows.


   **Note:** Vx.x denotes the version number of the SDK.

3. In SDK, the `ESI Files` directory contains the ESI files which can be loaded to EVB-LAN9252-HBI+ EEPROM using TwinCAT, as displayed in Figure 2-8.

   **FIGURE 2-7: FEATURES ON HBI+ BOARD**

   ![HBI+ Board Features](image)

   **FIGURE 2-8: ESI FILES DIRECTORY**

<table>
<thead>
<tr>
<th>ESI File name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microchip EVB-LAN9252-HBI-INDEXED-8BIT.xml</td>
<td>Configures LAN9252 in SPI with GPIO - 2-port mode.</td>
</tr>
<tr>
<td>Microchip EVB-LAN9252-HBI-INDEXED-16BIT.xml</td>
<td></td>
</tr>
<tr>
<td>Microchip EVB-LAN9252-HBI-MDP-8BIT.xml</td>
<td></td>
</tr>
<tr>
<td>Microchip EVB-LAN9252-HBI-MDP-16BIT.xml</td>
<td></td>
</tr>
<tr>
<td>Microchip EVB-LAN9252-HBI-MSP-8BIT.xml</td>
<td></td>
</tr>
<tr>
<td>Microchip EVB-LAN9252-HBI-MSP-16BIT.xml</td>
<td></td>
</tr>
<tr>
<td>Microchip EVB-LAN9252-HBI-SPI_MODE.xml</td>
<td></td>
</tr>
</tbody>
</table>

   **Note:** Refer to Appendix D. “Generating SSC Files” to change the Vendor ID and slave information in the ESI files.

4. Copy Microchip EVB-LAN9252-HBI-SPI_MODE.xml to the directory path `C:\TwinCAT\3.1\Config\Io\EtherCAT` for TwinCAT 3.1.

   **Note:** There can only be one microchip .xml file present in the directory path at a time. Please remove any .xml not being used.

6. By default, the corresponding ESI file of PIC32 firmware is flashed to the delivered EVB-LAN9252-HBI+. Refer to Appendix F. “Programming PIC32 Firmware Using Pre-Built Binaries”.

To change the firmware in PIC32 SoC, refer to Appendix D. “Generating SSC Files” and Appendix E. “Compiling and Programming SoC Firmware”.

Note: The pre-built binaries are available from the Binaries directory. This step can be skipped if pre-built binary is used for programming.

7. Launch TwinCAT and scan EtherCAT slaves from TwinCAT.

Refer to Appendix C. “Scanning EtherCAT Slaves” for steps on scanning EtherCAT slaves.

8. Program Microchip EVB-LAN9252-HBI-SPI_MODE.xml ESI file to EEPROM using TwinCAT.

Once the EEPROM has been programmed, power cycle the board without closing the TwinCAT project.

If the EEPROM programming is successful, state will change to ‘OP’ mode as displayed in Figure 2-9.

FIGURE 2-9: OP MODE

Note: If it changes to OP mode as highlighted above, then the device is in operational state. Otherwise there is an issue with the setup.
2.2.2 SPI Demo

The following describes a demo of EVB-LAN9252-HBI+ in SPI mode:

1. Follow the steps as provided in Section 2.2.1 “EtherCAT Master and Slave Configuration”. Nine demo objects, 4 outputs and 5 inputs, can be seen on the Solution Explorer of the TwinCAT tool, as displayed in Figure 2-10.

![SPI DEMO](image)

2. As part of this demo, nine object variables are mapped to LAN9252 GPIOs as in Table 2-2.

<table>
<thead>
<tr>
<th>Variable</th>
<th>LAN/PIC32 GPIOs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Potentiometer (Input)</td>
<td>PIC32 RB1</td>
</tr>
<tr>
<td>Temperature Sensor (Input)</td>
<td>PIC32 RB0</td>
</tr>
<tr>
<td>UART Read Dword (Input)</td>
<td>PIC32 RF2</td>
</tr>
<tr>
<td>DAC Input (Input)</td>
<td>PIC32 AETXEN and PIC32 AETXCLK</td>
</tr>
<tr>
<td>Push Button (Input)</td>
<td>PIC32 RD3</td>
</tr>
<tr>
<td>DAC (Output)</td>
<td>PIC32 RB2</td>
</tr>
<tr>
<td>UART Write Dword (Output)</td>
<td>PIC32 RF8</td>
</tr>
<tr>
<td>LAN9252 GPIO LEDs (Output)</td>
<td>LAN9252 GPO0-15</td>
</tr>
<tr>
<td>LED_D24 (Output)</td>
<td>PIC32 RD2</td>
</tr>
</tbody>
</table>

3. To change GPIO inputs, click the Inputs process data mapping option under Box 1 in the Solution Explorer, as displayed in Figure 2-10.

4. There are 5 different inputs that can be observed in Figure 2-11:
   - Potentiometer can be adjusted on the board (ADC Pot1: See Figure 2-7).
   - Temperature Sensor output can be used to calculate ambient temperature. Refer to Section 2.3.1 “Calculating Temperature” for more information.
   - UART Read Dword will display information seen on RX from J24 RS232 connector. It will be a decimal number reflecting 4 characters. Refer to Section 2.3.2 “UART Decimal to ASCII Conversion” for information on
converting this decimal number into hex and eventually ASCII.
- DAC Input will display the input data going into the PIC. Refer to Section 2.3.3 “DAC Calculations” for how this number is obtained.
- Push Button (SW50: See Figure 2-7) will be 1 when not pressed and 0 when pressed.

### FIGURE 2-11: INPUTS IN SPI MODE

<table>
<thead>
<tr>
<th>Name</th>
<th>Online</th>
<th>Type</th>
<th>Size</th>
<th>&gt; Ad.</th>
<th>In/O</th>
<th>User</th>
<th>Linked to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Potentiometer</td>
<td>511</td>
<td>UDINT</td>
<td>4.0</td>
<td>39.0</td>
<td>Input</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>235</td>
<td>UDINT</td>
<td>4.0</td>
<td>43.0</td>
<td>Input</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>UART Read</td>
<td>1482185281</td>
<td>UDINT</td>
<td>4.0</td>
<td>47.0</td>
<td>Input</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>DAC Input</td>
<td>251</td>
<td>UDINT</td>
<td>4.0</td>
<td>51.0</td>
<td>Input</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Push button</td>
<td>1</td>
<td>BIT</td>
<td>0.1</td>
<td>55.0</td>
<td>Input</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

5. To view GPIO outputs, click Outputs process data mapping under Box 1 in the Solution Explorer, as displayed in Figure 2-10.
6. There are 4 different outputs that can be observed in Figure 2-12:
   - DAC is a value that can be set and will adjust the DAC output voltage as well as the ADC output. Refer to Section 2.3.2 “UART Decimal to ASCII Conversion” for information on how to calculate this.
   - UART Write Dword will output the value entered through TX on J24 RS232 connector in a repeated fashion.
   - LAN9252 GPIO LEDs can be turned on and off by clicking on LAN9252 GPIO LEDs under the Outputs process data mapping. An example on how to do this and what it looks like on the board can be seen in Figure 2-13 and Figure 2-14 respectively.
   - LED_D24 (See Figure 2-7) can be set as high or low for on or off respectively.

### FIGURE 2-12: OUTPUTS IN SPI MODE

<table>
<thead>
<tr>
<th>Name</th>
<th>Online</th>
<th>Type</th>
<th>Size</th>
<th>&gt; Ad.</th>
<th>In/O</th>
<th>User</th>
<th>Linked to</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAC</td>
<td>0</td>
<td>UDINT</td>
<td>4.0</td>
<td>39.0</td>
<td>Out...</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>UART Write</td>
<td>0</td>
<td>UDINT</td>
<td>4.0</td>
<td>43.0</td>
<td>Out...</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>LAN9252 GPI...</td>
<td>33825</td>
<td>UDINT</td>
<td>4.0</td>
<td>47.0</td>
<td>Out...</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>LED_D24</td>
<td>0</td>
<td>BIT</td>
<td>0.1</td>
<td>51.0</td>
<td>Out...</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

### FIGURE 2-13: SETTING LAN9252 GPIO OUTPUTS

[Image of setting LAN9252 GPIO outputs]
2.3 EVB-LAN9252-HBI+ CALCULATIONS

2.3.1 Calculating Temperature

The Vout of the temperature sensor is connected to the ADC. The output of the ADC (ADCout) will be the value displayed in the EtherCAT application and be named Temperature Sensor. To get the output voltage (Vout) see Equation 2-1

EQUATION 2-1: TEMP SENSOR VOUT

\[
V_{out} = \left( \frac{ADC_{out} \times 3300mV}{1023mV} \right)
\]

Now use Vout and calculate the temperature in degrees Celsius (Equation 2-2):

EQUATION 2-2: TEMPERATURE

\[
Temp(°C) = \left( \frac{V_{out} - 500mV}{10mV} \right)
\]

EXAMPLE 2-1: ETHERCAT APPLICATION OUTPUTS 235 (ADCOUT=235).

\[
V_{out} = \left( \frac{235 \times 3300mV}{1023mV} \right) = 758.06mV
\]

\[
Temp(°C) = \left( \frac{758.06mV - 500mV}{10mV} \right) = 25.8°C
\]
2.3.2 UART Decimal to ASCII Conversion

The EtherCAT application will display the UART input as decimal. This decimal number represents 4 different characters. Example 2-2 details how to convert from a decimal number to hex and then ASCII. The characters entered in order were a, A, 1, !.

**EXAMPLE 2-2: DECIMAL TO HEX TO ASCII**

Decimal = 556876129  
Hex = 0x21314161  
ASCII = 21 = !  
ASCII = 31 = 1  
ASCII = 41 = A  
ASCII = 61 = a

2.3.3 DAC Calculations

Depending on the value entered into the DAC Output, a calculated voltage will be present on the DAC output. This voltage is then sent to the ADC on the PIC and this number is displayed on the DAC input. An example can be found in Example 2-3 below. The first equation needed is the calculation of the output voltage of the DAC (Equation 2-3).

**EQUATION 2-3: DAC OUT**

\[
\text{DACout} = \frac{(3300\text{mV} \times \text{DAC})}{\# \text{ of Resistors in Ladder}}
\]

The \# of Resistors in Ladder will always be 4096 for this board.

After calculating the DAC output voltage, it is possible to determine the value produced from the ADC (Equation 2-4).

**EQUATION 2-4: ADC OUT**

\[
\text{ADCout} = \frac{(\text{DACout} \times 1023)}{3300}
\]

1023 is the MAX ADC according to the ADC Transfer Function.

**EXAMPLE 2-3: A VALUE OF 1250 IS ENTERED INTO THE DAC OUTPUT.**

\[
\text{DACout} = \frac{(3300\text{mV} \times 1250\text{mV})}{4096} = 1007\text{mV}
\]

\[
\text{ADCout} = \frac{(1007\text{mV} \times 1023)}{3300\text{mV}} = 312
\]
Appendix A. Setting Up Master in Windows®

A.1 INTRODUCTION
This appendix details how to setup a Master in Windows®.


A.1.1 TwinCAT Ethernet Driver - Installation
To install the TwinCAT Ethernet Driver:

1. If TwinCAT installed successfully, a TwinCAT icon will display in the bottom-right corner of the desktop. Click the TwinCAT icon.
   A pop-up menu displays.

2. Select TwinCAT XAE (VS XXXX), as displayed in Figure A-1.

   Note: VS XXXX refers to the version of Visual Studio installed on the computer.

3. Go to TWINCAT> Show Real Time Ethernet Compatible Devices... as in Figure A-2.

   ![Figure A-1: System Manager](image)
4. Select the network adapter and install the TwinCAT driver as in Figure A-3.
Once the TwinCAT driver is installed successfully, the driver is compatible with the TwinCAT master. The network adapter will then be moved to “Installed and ready to use devices” as displayed in Figure A-4.

**FIGURE A-4: INSTALLED AND READY TO USE DEVICES**

![Network Adapter Properties](image)

5. Go to the corresponding network adapter properties and then select TwinCAT drivers as displayed in Figure A-5 and Figure A-6. To access network adapter properties as seen in the figures below go to Control Panel\Network and Internet\Network Connections.
FIGURE A-5: NETWORK ADAPTER PROPERTIES MENU

FIGURE A-6: LOCAL AREA CONNECTION PROPERTIES

Note 1: Only select TwinCAT drivers.

2: If TwinCAT cannot find the EtherCAT slaves after following the steps in Appendix C. “Scanning EtherCAT Slaves”, restart the computer and attempt to scan again.
Appendix B. EEPROM Programming

B.1 INTRODUCTION

This appendix shows how to program EEPROM.

B.1.1 EEPROM Programming

To program EEPROM:

1. After a successful scan, click the arrow next to “Device 2 (EtherCAT)” on the Solution Explorer in the TwinCAT tool, as displayed in Figure B-1.

2. Click the Online tab in the TwinCAT project window.

3. Right-click the LAN9252 listing and select EEPROM Update from the contextual menu, as displayed in Figure B-2.
The Write EEPROM window displays.

4. Select the corresponding EEPROM configuration and then click **OK** to initiate EEPROM programming.

For example, **Figure B-3** shows LAN9252 one of DIGIO configuration is selected for EEPROM programming in TwinCAT.

**Note:** The xml file that is to be programmed MUST be copied into "C:\TwinCAT\3.1\Config\Io\EtherCAT"
FIGURE B-3: WRITE EEPROM DIALOG

Available EEPROM Descriptions:

- Microchip
- Microchip PIC32 Slaves
- PIC32 EtherCAT Slave (37496/7)

[Image of the write EEPROM dialog window]
Appendix C. Scanning EtherCAT Slaves

C.1 INTRODUCTION

This appendix shows how to scan EtherCAT Slaves.

C.1.1 Scanning EtherCAT Slaves

To scan EtherCAT slaves:

1. Connect Port 0 of the device to the master using RJ45 Ethernet cable, and then power up the board. The Link/Act LED should be ON at Port 0 when the cable is present. If the Link/Act LED is not ON, it indicates there is an issue with the connection or cable.

2. If any devices are present, delete them accordingly by right-clicking the device and selecting Remove, as displayed in Figure C-1.

3. Scan for EtherCAT slave devices by right-clicking Devices under I/O and then selecting Scan, as displayed in Figure C-2.
4. Click **OK** to continue scanning as in **Figure C-3**.

If the check box is not checked as displayed in **Figure C-4**, then either the device is not functional or the driver is not installed properly.
5. Click Yes as displayed in Figure C-5 to scan for boxes.

FIGURE C-5:  CONFIRMATION DIALOG

6. Click Yes as displayed in Figure C-6 to allow free run.

FIGURE C-6:  CONFIRMATION DIALOG 2
7. The device list is displayed as seen in Figure C-7.

**FIGURE C-7: DEVICE LIST**

8. After a successful scan, there will be activity on Link/Act LED at Port 0 (It will blink rapidly).
Appendix D. Generating SSC Files

D.1 INTRODUCTION

This appendix details how to generate SSC files. These files can be found here: http://www.microchip.com/SWLlibraryWeb/producttc.aspx?product=LAN9252%20EtherCAT%20SDK

D.1.1 Generating SSC Files

To generate SSC files:

1. Start the SSC Tool from the Windows Start menu, as displayed in Figure D-1.

   FIGURE D-1: SSC TOOL

2. From the menu bar, click File>New as displayed in Figure D-2.

   FIGURE D-2: NEW ETHERCAT SLAVE

3. Click Import to import the SSC Tool configuration file Microchip EVB-LAN9252-HBI-SPI-SSC-CONFIG.xml from the directory {SDK_INSTALL_PATH}/EVB-LAN9252_SDK_VX.X/SSC/ as displayed in Figure D-3.
After selecting the file, click **Open** to import the SSC Tool configuration file.

4. Once imported, check the “Custom” drop-down box, select the “Microchip-EVB-LAN9252-HBI” configuration, and then click **OK**, as displayed in **Figure D-4**.

5. All listed parameters under the **Slave Information** tab can be changed, as displayed in **Figure D-5**.

**Note:** By default, SDK ESI files have an object configuration with Microchip Vendor ID.
6. Click Tool>Application>Import from the menu bar, as displayed in Figure D-6.

FIGURE D-6: IMPORT MENU

7. Select the file pic32_mchp_gpio_sample_app.xlsx which can be found in the directory {SDK_INSTALL_PATH}/EVB-LAN9252_SDK_VX.X/HBI Application/ or {SDK_INSTALL_PATH}/EVB-LAN9252_SDK_VX.X/SPI Application/ depending on the mode the board is configured for.

pic32_mchp_gpio_sample_app.xlsx is an object file which contains the information about application objects.

A status message displays as in Figure D-7.
FIGURE D-7: STATUS MESSAGE

8. Click **OK** to continue.
9. From the menu bar, click **Project>Create New Slave Files**.
   The Create new Slave Files window displays, as in **Figure D-8**.
10. Click the Windows **Start** button to create a new project file, Src folder, and ESI file (Slave Information file) in the desired directory path.
    A pop-up window will indicate that the files have been successfully created.

11. Click **OK** to continue.
    Along with generated new slave files, an ESI file (.xml file) also will be generated. This ESI file will have information about new Vendor ID and object configuration. Program this ESI file into EEPROM as mentioned in **Appendix B. “EEPROM Programming”**.

12. Replace generated application files with SDK application files as displayed in **Figure D-9**.
    SDK Application files can be found the either the HBI Application or SPI Application and then Sample Application Files depending on the board configuration.

**Note:** The above values signify the following:
- **$PROJECT_FILE_PATH** - The location where the SSC project file is saved.
- **$SRC_FILE_PATH** - Default path is $PROJECT_FILE_PATH. It can be changed by clicking its corresponding **Change** button.
- **$ESI_FILE_PATH** - Default path is $PROJECT_FILE_PATH. It can be changed by clicking its corresponding **Change** button.
13. Browse to the directory where the new files were created, as shown in the example:
   - **Src (Folder):** This folder contains the Beckhoff Slave Stack code.
   - **Microchip PIC32 Slaves (ESP):** This is the SSC Tool project file.
   - **Microchip PIC32 Slaves (XML):** This is the EtherCAT slave information file that must be used as an input to the EtherCAT master tool to configure EtherCAT slave controllers.

14. Copy all the files inside the **Src** folder to the following directory:
    `{SDK_INSTALL_PATH}/EVB-LAN9252-HBI_PIC32_SDK_VX.X/SSC/Common`

### D.1.1.1 WHY REPLACE IS REQUIRED

Generated application files will not have the code for accessing the GPIO lines. GPIO support is provided in delivered SDK application files. Hence, the replace is required to get the demo application.
Appendix E. Compiling and Programming SoC Firmware

E.1 INTRODUCTION

This appendix details how to compile and program SoC firmware.

E.1.1 Compiling and Programming SoC Firmware

To compile and program SoC firmware:

1. Open the MPLAB IDE and import the SSC project.
   
   The MPLAB project file is located under `{SDK_INSTALL_PATH}/EVB-LAN9252-HBI_PIC32_SD-K_VX.X/SSC/`.

2. Compile the source code as displayed in Figure E-1.

   FIGURE E-1: SOURCE CODE

   ![Clean and Build Project (SSC)](image)

   If the compilation is successful, the output window will display "BUILD SUCCESSFUL" as shown in Figure E-2.

   FIGURE E-2: BUILD SUCCESSFUL

   ![Build successful](image)

   3. Before initiating the firmware download, ensure the debugger/programmer is connected to the EVB’s JTAG pins.

   **Note:** This demo project is debugged with the PICkit-3 In-Circuit debugger/programmer.

   4. To program the PIC32 SoC, click the Make and Program Device Main Project button, as displayed in Figure E-3.
5. To debug the PIC32 SoC, click the **Debug Main Project** button, as displayed in Figure E-4.

**FIGURE E-4:** DEBUG MAIN PROJECT BUTTON
Appendix F. Programming PIC32 Firmware Using Pre-Built Binaries

F.1 INTRODUCTION

This appendix shows how to program PIC32 firmware.

F.1.1 Programming PIC32 Firmware Using Pre-Built Binaries

To program the PIC32 firmware using pre-built binaries:

1. Download and install MPLAB IPE V X.X from the following link:
   http://microchip.wikidot.com/ipe:installation

   Note: x.xx denotes the version number of the MPLAB IPE.

2. Before initiating the firmware download, ensure the debugger/programmer is connected to the EVB’s JTAG pins.

3. Open the MPLAB IPE.
   The window displays as in Figure F-1.
4. Select the corresponding device from the “Device” drop-down box and then click **Apply**.
5. Select the debugger/programmer from the “Tool” drop-down box and then click **Connect**.
6. From “Source,” click the **Browse** button and select the hex files which can be found in the “Binaries”
directory of \EVB-LAN9252-HBI_PIC32_SDK V X.X.
7. Once the hex files are loaded, click **Program**.
Appendix G. Troubleshooting

G.1 INTRODUCTION
This appendix details how to troubleshoot some issues that may occur when using the EVB-LAN9252-HBI+. If the issue cannot be resolved using this troubleshooting appendix, please use the Microchip website to request further assistance.

G.1.1 Cannot Program PIC32
If the situation arises where the PIC32 will not program, ensure the proper header is being used. DO NOT USE J14 to Program the PIC32. DO USE J13 to program the PIC32. Align PIN1 of the programming device with PIN1 of the header as labeled on the board.

G.1.2 Error when board requests PREOP
If an error similar to that seen in Figure G-1 occurs, it could be the result of two possible issues:

FIGURE G-1: PREOP FAILURE

1. The board is not configured correctly to use the desired mode. Please refer back to Section 2.1.1 “EtherCAT Master and Slave Configuration” for information on the proper configuration of the board for HBI mode and Section 2.2.1 “EtherCAT Master and Slave Configuration”
for information on the proper configuration of the board for SPI mode.

2. After programming the board’s EEPROM, one must follow the following steps:
   1: Remove the device as seen in Figure G-2
   2: Power cycle the board
   3: Rescan for devices

![FIGURE G-2: REMOVING A DEVICE](image)

G.1.3 Values Do not Update in Application

If this issues occurs, please power cycle or reset the board and try changing the output value again. If the input values do not update please also power cycle or reset the board.
## Worldwide Sales and Service

### AMERICAS

<table>
<thead>
<tr>
<th>City</th>
<th>Address</th>
<th>Tel</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atlanta</td>
<td>2355 West Chandler Blvd.</td>
<td>678-957-9614</td>
<td>678-957-1455</td>
</tr>
<tr>
<td>Austin, TX</td>
<td>Tel: 512-257-3370</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Boston</td>
<td>Westborough, MA</td>
<td>774-760-0087</td>
<td>774-760-0088</td>
</tr>
<tr>
<td>Chicago</td>
<td>Itasca, IL</td>
<td>630-285-0071</td>
<td>630-285-0075</td>
</tr>
<tr>
<td>Cleveland</td>
<td>Independence, OH</td>
<td>216-447-0464</td>
<td>216-447-0643</td>
</tr>
<tr>
<td>Dallas</td>
<td>Addison, TX</td>
<td>972-818-7423</td>
<td>972-818-2924</td>
</tr>
<tr>
<td>Denver</td>
<td>Novi, MI</td>
<td>248-848-4000</td>
<td></td>
</tr>
<tr>
<td>Houston, TX</td>
<td>Tel: 281-894-5983</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indianapolis</td>
<td>Noblesville, IN</td>
<td>317-773-8323</td>
<td>317-773-5453</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>Mission Viejo, CA</td>
<td>949-462-9523</td>
<td>949-462-9608</td>
</tr>
<tr>
<td>New York, NY</td>
<td>Tel: 631-435-6000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>San Jose, CA</td>
<td>Tel: 408-735-9110</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Canada - Toronto</td>
<td>Tel: 905-673-0699</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### ASIA/PACIFIC

<table>
<thead>
<tr>
<th>City</th>
<th>Address</th>
<th>Tel</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hong Kong</td>
<td>37th Floor Tower 6, Gateway</td>
<td>852-2943-5100</td>
<td>852-2401-3431</td>
</tr>
<tr>
<td>China</td>
<td>Tel: 61-2-9868-6733</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Australia</td>
<td>Sydney</td>
<td>61-2-9868-6755</td>
<td></td>
</tr>
<tr>
<td>Beijing</td>
<td>Tel: 86-10-8569-7000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chengdu</td>
<td>Tel: 86-28-8665-5511</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chongqing</td>
<td>Tel: 86-23-8960-9588</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dongguan</td>
<td>Tel: 86-769-8702-9880</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Guangzhou</td>
<td>Tel: 86-20-8755-8029</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hangzhou</td>
<td>Tel: 86-571-8792-8115</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hong Kong</td>
<td>Tel: 86-755-8864-2200</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shanghai</td>
<td>Tel: 86-21-5407-5533</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shenyang</td>
<td>Tel: 86-24-2334-2829</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shenzhen</td>
<td>Tel: 86-755-8203-1760</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wuhan</td>
<td>Tel: 86-27-5980-5300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Xian</td>
<td>Tel: 86-29-8833-7252</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### ASIA/PACIFIC

<table>
<thead>
<tr>
<th>Country</th>
<th>Tel</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>China</td>
<td>86-592-2388138</td>
<td>86-592-2388130</td>
</tr>
<tr>
<td>India</td>
<td>91-80-3090-4444</td>
<td>91-80-3090-4132</td>
</tr>
<tr>
<td>India</td>
<td>91-11-4160-8611</td>
<td>91-11-4160-8632</td>
</tr>
<tr>
<td>Japan</td>
<td>81-6-6152-7160</td>
<td>81-6-6152-9310</td>
</tr>
<tr>
<td>Korea</td>
<td>82-53-744-4301</td>
<td>82-53-744-4302</td>
</tr>
<tr>
<td>Malaysia</td>
<td>60-3-6201-9857</td>
<td>60-3-6201-9859</td>
</tr>
<tr>
<td>Malaysia</td>
<td>60-4-227-8870</td>
<td>60-4-227-4068</td>
</tr>
<tr>
<td>Philippines</td>
<td>63-2-634-9065</td>
<td>63-2-634-9069</td>
</tr>
<tr>
<td>Singapore</td>
<td>65-6334-8870</td>
<td>65-6334-8850</td>
</tr>
<tr>
<td>Taiwan</td>
<td>886-3-5778-366</td>
<td>886-3-5770-955</td>
</tr>
<tr>
<td>Taiwan</td>
<td>886-7-213-7828</td>
<td></td>
</tr>
<tr>
<td>Thailand</td>
<td>66-2-694-1351</td>
<td>66-2-694-1350</td>
</tr>
</tbody>
</table>

### EUROPE

<table>
<thead>
<tr>
<th>Country</th>
<th>Tel</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austria</td>
<td>43-7242-2244-39</td>
<td>43-7242-2244-39</td>
</tr>
<tr>
<td>Denmark</td>
<td>45-4450-2828</td>
<td>45-4485-2829</td>
</tr>
<tr>
<td>Germany</td>
<td>49-2129-3766400</td>
<td></td>
</tr>
<tr>
<td>Germany</td>
<td>49-721-625370</td>
<td></td>
</tr>
<tr>
<td>Germany</td>
<td>49-89-627-144-0</td>
<td>49-89-627-144-4</td>
</tr>
<tr>
<td>Italy</td>
<td>39-0331-742611</td>
<td>39-0331-466781</td>
</tr>
<tr>
<td>Italy</td>
<td>39-049-7625286</td>
<td></td>
</tr>
<tr>
<td>Netherlands</td>
<td>31-416-690399</td>
<td>31-416-690340</td>
</tr>
<tr>
<td>Poland</td>
<td>48-22-3325737</td>
<td></td>
</tr>
<tr>
<td>Spain</td>
<td>34-91-708-08-90</td>
<td>34-91-708-08-91</td>
</tr>
<tr>
<td>Sweden</td>
<td>46-8-5090-4654</td>
<td></td>
</tr>
<tr>
<td>UK</td>
<td>44-118-921-5800</td>
<td>44-118-921-5820</td>
</tr>
</tbody>
</table>

06/17/16